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15 October 2003 

MEMORANDUM FOR SEE DISTRIBUTION 

FROM: SAF/IAPX 
1080 Air Force, Pentagon 
Washington,  DC  20330-1080 

SUBJECT: New Policy, Procedures and Processes for Leases and Excess Defense Articles 
(EDA) (SAF/IAPX 03034) 

References: (a) DSCA ltr I-02/016522-P2, Implementation of Electronic Countersignature 
Processing for Leases (DSCA 03-16) of 1 Aug 03 

  (b) DSCA ltr I-02/016347-P2, Implementation of Multiple Duration Leases (DSCA 
03-17) of 7 Aug 03 

 This memorandum implements DSCA guidance for electronic countersignature of all 
leases and the use of multiple duration lease lines.  This memorandum will also address 
procedures for lease and Excess Defense Articles (EDA) pricing and the initialization/ 
development of leases in DSAMS. 

Electronic Countersignature - The procedure for electronic countersignature of LOA’s was 
implemented in 2001.  Effective immediately, this procedure is mandatory for all country leases 
with the exception of emergency situations and classified leases.  For these exceptions only, 
DSCA will accept hard copy documents.  All DSAMS milestones must still be entered for these 
documents.  DSCA should be notified in advance of these documents being processed in 
hardcopy form.  As in the case of all LOA’s, SAF/IAPX will be provided all back-up 
documentation electronically, such as Letter(s) of Request (LOR’s), any pricing back-up data or 
worksheets provided by SAF/FMBIS, or any waivers associated with the lease.  SAF/FMBIS 
should provide to the country director, back-up pricing information in either a .pdf or .tif file.  
Each of these documents must be provided to SAF/IAPX in a .pdf or .tif file and each file must 
contain the country and lease identifier.  Once the electronic packages are assembled and 
coordination is complete, they will be e-mailed to SAF/IAPX.  SAF/IAPX will then 
electronically send completed package to DSCA for countersignature.  Separate correspondence 
will be provided by SAF/IAPX with a point of contact.   Once the lease is countersigned and 
SAF/IAPX has been notified through DSAMS that the lease is in the “offered” status, the 
document will be signed in SAF/IAPX and returned to the country director for forwarding to the 
country.  Per DSCA policy the “Lease Certificate of Determination” is now printed out by DSCA 
and signed by Director, DSCA prior to the DSCA countersignature milestone being posted in 
DSAMS. 



 

 

 

 

 

Multiple-Duration Leases - DSAMS Release 6.09 (release date August 2003) has the capability 
to allow for the use of multiple duration lease lines.  It also changes the line sequencing from 
alphas to numerical.   In the past, there has been a limitation to a set lease duration period, not to 
exceed five years, for all items contained in a particular lease.  This generated the need for many 
lease amendments to reflect the actual time period and rental payment for each item that was 
leased.  When a country director is advised that the forecasted and actual item return dates have 
changed, an amendment will be initiated with a changed duration period.  Lease durations will 
continue to be calculated in months only.  The shortest duration time is one month, and the 
longest duration time period is 60 months.  The time period required to complete a major 
refurbishment is not calculated as a part of the lease duration period.  At the time of 
development/development of the lease, any lines that have a different duration than the total time 
of the lease, need to be identified to SAF/IAPX. 

Procedures for Requesting Lease and EDA Pricing - This memo formalizes the procedures 
for the request of lease or EDA pricing items from SAF/FMBIS and SAF/IARW.  This 
procedure is effective immediately.  Country directors and SPO’s must coordinate all lease and 
EDA pricing requests and issues with SAF/FMBIS and SAF/IARW.  A checklist has been 
attached as the vehicle to ensure that all information necessary to complete lease and EDA 
pricing is complete.   Separate correspondence will be provided by SAF/FMBIS and SAF/IARW 
with designated points of contact within FMBIS and IARW for pricing issues. 

Initialization and Development of Leases within DSAMS - When a requirement is received 
from the country for the leasing of equipment, please contact SAF/IAPX to obtain a lease 
designator for the development/development of the lease in DSAMS.  SAF/IAPX will then begin 
the development of the lease based on information provided in the LOR or direction from the 
country director.  At this time, SAF/IAPX will formally task SAF/FMBIS through DSAMS all 
lines that require pricing.  When pricing is complete, SAF/FMBIS will task SAF/IAPX to 
complete the lease development.  A draft copy will be provided to the country director to 
complete the coordination process. 

 This memo has been fully staffed and coordinated with SAF/IA and SAF/FMBIS.  
SAF/IAPX POC is Colleen A. Henson, 703-588-8975, colleen.henson@pentagon.af.mil. 

       //signed// 

   TERRY L. BATES 
   Chief, Security Assistance Policy Division 
   Directorate of Policy 



          
         In reply refer to: 
         I-02/016522-P2 
 
MEMORANDUM FOR DEPUTY UNDER SECRETARY OF THE ARMY 

(DEFENSE EXPORTS AND COOPERATION) 
(DASA(DE&C)/SAAL-ZN) 
DEPARTMENT OF THE ARMY 
 
DEPUTY ASSISTANT SECRETARY OF THE NAVY 
(INTERNATIONAL PROGRAMS) 
DEPARTMENT OF THE NAVY 
 
DEPUTY UNDER SECRETARY OF THE AIR FORCE 
(INTERNATIONAL AFFAIRS) 
DEPARTMENT OF THE AIR FORCE 
 
DEPUTY DIRECTOR FOR SECURITY ASSISTANCE 
DEFENSE FINANCE AND ACCOUNTING SERVICE 
DENVER CENTER 

 
SUBJECT:  Implementation of Electronic Countersignature Process for Leases (DSCA 

03-XX) 
 
REFERENCE:  (a) DSCA Memorandum 01-21 “Implementation of Electronic 

Countersignature Process” 
 
 (b) Arms Export Control Act, Chapter 6 
  
  
Reference (a) implemented the electronic coordination and countersignature of Letter of 
Offer and Acceptance (LOA) documents.  This capability was initially limited to LOA 
documents, in that the authority to sign one of the lease documents cannot be delegated 
below the Director, DSCA, and additionally, the ability to generate PDF files of leases 
was not available.  These issues have been worked through, and leases will now be 
electronically coordinated and countersigned.  The following policy guidance and 
instructions are provided for this purpose and should be given wide distribution to 
everyone involved in the document preparation and coordination process of leases.   
 

a. Electronic countersignature procedures will be mandatory for all countries’ leases.  
DSCA will continue to accept hardcopy documents for emergency situations and 
classified leases.  All DSAMS milestones must still be entered for these documents 
and DSCA should be notified in advance that these documents will be processed in 
hardcopy form.   
 



b. DSCA will be notified automatically when lease documents have moved to 
“proposed” status in DSAMS.  We will then be expecting to receive an e-mail 
requesting our approval and forwarding all applicable files (cover memorandum, and 
when required, the congressional notification certification).  All e-mails submitting 
packages for countersignature must be sent to policy-dsca@dsca.mil.  DSCA cannot 
review the package until both of these actions have taken place – the “proposed” 
status change and receipt of the e-mail.   

 
c. In order to discriminate between lease documents received electronically, we are 
requiring a specific naming convention for files submitted for countersignature.  Each 
e-mail subject line and each PDF file for a lease should include the lease designator.  
If the lease is an amendment, that too should be addressed in the naming of the lease 
file.  For example, a DSCA lease to Bandaria could have the following file names: 
“BN-Q-ZAA B.pdf” (for a basic lease) or “BN-Q-ZAA A2.pdf” (for amendment 2).  
The subject line of the e-mail should reflect the same name as the lease file 
attachment. 

 
d. The electronic countersignature process requires the use of DSAMS and Adobe 
Writer for PDF file creation.  Instructions on how to create a PDF file of a lease in 
DSAMS are attached.  The PDF lease files are to be submitted to                       
policy-dsca@dsca.mil. 

 
e. As with LOAs, DSCA reviewers will now be entering their comments in the 
“Lease Remarks” section of DSAMS.  This field is at the “lease” level and does not 
automatically identify which document version the reviewer is commenting on (e.g., 
Amendment 2, Basic Lease, etc.).  To make it easier to track these comments, we will 
require DSCA reviewers to use a specific format when creating a title for their 
comments.  The title must be entered as follows:  Document Version, Revision 
Number (if applicable), Individual’s Office, Concur/Nonconcur.  A sample entry 
might read:  “A02, Rev2, ERASA-ASA, Nonconcur.”  DSCA reviewers must enter 
Lease Remarks for all nonconcurrences.  Comments may also be entered for 
concurrences (optional). 
 
f. Implementing agencies should use existing DSAMS Management Flags to 
provide notification, as a minimum, when documents have been countersigned by 
DSCA (Milestone -- DCSGN), returned from DSCA (Milestone -- DDOCRTN), or 
rejected from DSCA (Milestone -- DCSGNRJ).   

 
g. When the lease is countersigned and the implementing agency has received 
notification that the lease is in “offered” status, the implementing agency will sign the 
document and send it to the customer.  At this time, the implementing agency will 
also be responsible for sending a hardcopy of the document to DFAS-DE/AY. 
 

Reference (b) requires that a determination be made that there are compelling foreign 
policy and national security reasons for leasing, rather than selling defense articles, and 
that the defense articles are not for the duration of the lease needed for public use.  The 



authority to make this determination is not delegated below the Director, DSCA, and will 
continue to require his/her signature, vice an electronic signature.  DSAMS report RP111 
“Lease Certificate of Determination” generates the lease determination, which will be 
printed out by DSCA and signed by Director, DSCA prior to the DSCA Countersignature 
Milestone (DCSGN) being posted in DSAMS. 
 
If you have any questions regarding this matter, please feel free to contact Ms. Dawn 
Burke at (703) 601-3864 or e-mail dawn.burke@dsca.mil.  Guidance in this 
memorandum is effective immediately.  Thank you for your cooperation. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Attachments: 

(1) Lease Milestone Matrix 
(2) Creating Lease PDF Files 

 
 
 
 
cc: DSADC 
     USASAC 
     AFSAC 
 



Attachment 1 
Lease Milestone Matrix 

 
MILESTONE NAME DETAILS 

 
LEASEINIT  Lease Initialized DSAMS creates this milestone when a lease is created 

(Initialize Lease Window). 
 

DSTATUS  Case Status 
'Development' 

Any case versions created will create this milestone.  
Whenever the case version is "Restated", this milestone 
will be created.  Whenever a case version is 
returned/rejected by DSCA or the State Department, 
this milestone is created. 
 

LEASEASGN  Lease Assigned to 
Preparer 

DSAMS creates this milestone when the PREPLEASE 
workflow task is assigned to an activity (Assign Task 
Window). 
 

LEASERETD  Lease Returned 
from Preparer 

DSAMS creates this milestone when the PREPLEASE 
workflow task is completed (Complete Task Window). 
 

MILAP  MilDep Approval Enter this milestone when the case version document is 
approved by the MILDEP document (Case Milestone 
List Window). 
 

MILSGN  MilDep Signature Enter this milestone when the MILDEP has signed the 
case version document (Case Milestone List Window).  
There must be a MILAP milestone for the case version 
before this milestone can be created.  When you enter 
this milestone, the case version status will be changed 
to the appropriate status. 
 

DAPREQ  DSCA Apprvl 
Requested 

Enter this milestone when the case version document 
was sent to DSCA for approval and countersignature  
(Case Milestone List Window). 
 

PSTATUS  Case Status 
'Proposed' 

DSAMS will create this milestone when the case 
version status is changed to "Proposed".  If you are 
changing the case version status from "Development" 
to "Proposed", there must be a MILAP and MILSGN 
milestone before this milestone can be created.  If you 
are changing the case version status from "Canceled" to 
"Proposed", there must be a MILAP and MILSGN 
milestone; and no ASTAP and OSTATUS milestone 
before this milestone can be created.   
 
 
 
 

 



MILESTONE NAME DETAILS 
 

DOCMNTSENT  Document Sent 
from IA 

Enter this milestone to indicate when the document 
(Lease, modification, etc.) has been sent to the 
customer. 
 

SDWVR Secretary of 
Defense Waiver 
Requested 

Enter this milestone when a waiver is requested from 
the Secretary of Defense for the case  (Case Milestone 
List Window). 
 

SDWVRAP Secretary of 
Defense Waiver 
Approved 

Enter this milestone when a waiver is approved by the 
Secretary of Defense for the case  (Case Milestone List 
Window).  There must be a SDWVR milestone for the 
case version before this milestone can be created. 
 

SDWVRRJ Secretary of 
Defense Waiver 
Rejected 

Enter this milestone when a waiver is rejected by the 
Secretary of Defense for the case  (Case Milestone List 
Window).  There must be a SDWVR milestone for the 
case version before this milestone can be created. 
 

DCSGNRJ DSCA Rejection Enter this milestone when the case version document 
was rejected by DSCA (Case Milestone List Window).  
There must be a DAPCS milestone for the case version 
before this milestone can be created. 
 

DDOCRTN DSCA Document 
Return 

The date that DSCA returns an unapproved document 
to the MILDEP based on MILDEP request.  This 
milestone is not used to indicate that the document has 
been rejected.  Milestone DCSGNRJ is used to indicate 
rejection. 
 

CSTANOT  Statutory 
Notification to 
Congress 

Enter this milestone when the DSCA submits the 
statutory Section 62(a) notification to the Congress 
(DSCA Statutory Congressional Notification Window). 
 

STANOTEND  Statutory 
Notification 
Period Ends 

DSAMS creates this milestone when you enter the 
DSCA submittal of the statutory Section 62(a) 
notification to the Congress (DSCA Statutory 
Congressional Notification Window).  The milestone 
date is based on the Period End Date calculated or 
entered in the window. 
 

STLST  State Department 
List 

DSAMS creates this milestone when the State 
Department List was submitted by DSCA.  This 
milestone is not applicable to leases, however, due to 
the setup of DSAMS, it must be posted before the 
DCSGN milestone can be posted. 
 
 

 



MILESTONE NAME DETAILS 
 

DCSGN  DSCA 
Countersignature 

Enter this milestone when the case version document 
was countersigned by DSCA (Case Milestone List 
Window).  There must be a DAPCS, MILAP and 
STAP (if the State Department Approval checkbox is 
checked) milestone for the case version before this 
milestone can be created. 
 

STAP  State Department 
Approval 

Enter this milestone when the State Department 
approves the Section 62(a) case version document 
(Case Milestone List Window).  There must be a 
DSTATUS and MILAP milestone for the case version 
before this milestone can be created. 
 

OFFERED  Offered Enter this milestone when the case version status is 
ready to be changed to Offered.   There must be a 
MILSGN milestone for the case version before this 
milestone can be created.  When you enter this 
milestone, the case version status will be changed to 
"Offered". 
 

OSTATUS  Case Status 
'Offered' 

DSAMS will create this milestone when the case 
version status is changed to "Offered".  If you are 
changing the case version status from "Development" 
or "Proposed" to "Offered", there must be a MILAP, 
MILSGN, OFFERED, DCSGN and STAP milestone 
before this milestone can be created.  If the 
Congressional Notification Checkbox is checked, there 
must be a STANOTEND milestone.   
 

OFFERACC  Offer Accepted 
by Customer 

Enter this milestone when the customer signs the case 
version document (Case Milestone List Window).  
Enter the customer signature date as the milestone date.  
When you enter this milestone, the case version status 
will be changed to "Accepted". 
 

CGDISCREP  CG and DSAMS 
Values Disagree 

DSAMS creates this milestone when the CG 
Transactions from DIFS do not match the DSAMS 
Values.  DSAMS performs a validation of the Total 
and Net Case Values between the DSAMS computed 
values and the CG values.  If these values do not 
match, this milestone is created. 
 
 
 
 
 
 
 



MILESTONE NAME DETAILS 
 

ASTATUS  Case Status 
'Accepted' 

DSAMS will create this milestone when the case 
version status is changed to "Accepted" (Case 
Milestone List Window - Tools/MILDEP 
Options/Offer Accepted).  If you are changing the case 
version status from "Offered" to "Accepted", there 
must be an OFFERACC milestone before this 
milestone can be created. 
 

DOCVAL  Document 
Validation 

(Navy) Enter this milestone when the case version has 
been validated. 
 

FINIMP  Financial 
Implementation 

DSAMS creates this milestone when DFAS indicates 
that all financial requirements have been met (initial 
deposit received).  NOTE:  This does not implement 
the case version in DSAMS. 
 

MILIMP  MilDep 
Implementation 

DSAMS will generate this milestone when the 
MILDEP manually implements a case version (Case 
Milestone List Window). 
 

ISTATUS  Case Status 
'Implemented' 

DSAMS will create this milestone when the case 
version status is changed to "Implemented".  If you are 
changing the case version status from "Accepted" to 
"Implemented", there must be a FINIMP, OAAPPROV 
(required by Army and Navy only) milestones before 
this milestone can be created. 
 

LEASEEXP  Lease Expiration Identifies the date that a lease will expire.  This 
milestone will be created when the lease document is 
implemented. 
 

CSTATUS Case Status 
"Closed" 

DSAMS will create this milestone when the case status 
is changed to "Closed".  This milestone will be 
associated with the current implemented case version.  
 

 



Attachment 2 
Creating Lease PDF Files 

 
 
 To create a PDF file of a lease in DSAMS, the following steps are required: 
 

a. Go to the View menu in DSAMS 
b. Select Response Documents 
c. Select RP109 Lease 
d. Enter the lease designator data 
e. Lease Previewer will display the Lease 
f. Go to the File menu in the Previewer 
g. Select Print 
h. Go to the Name dropdown menu to select printer (you will not actually print a 

document from your printer) 
i. Select Client\(user name)\Acrobat Distiller for your printer 
j. Select OK 
k. Assign a file name to the lease, using the lease designator as the name, when 

prompted 
l. Acrobat Writer will open, and display the PDF file of the lease 
m. Go to the File menu in Acrobat Writer 
n. Select Send Mail 
o. An e-mail will open with the lease attached 
p. Attach a copy of the forwarding cover memorandum, and when required, the 

congressional notification certification to the e-mail 
q. State the document name in the e-mail’s subject field 
r. Send the e-mail to policy-dsca@dsca.mil 



          
         In reply refer to: 
         I-02/016347-P2 
         7 August 2003 
 
MEMORANDUM FOR DEPUTY UNDER SECRETARY OF THE ARMY 

(DEFENSE EXPORTS AND COOPERATION) 
(DASA(DE&C)/SAAL-ZN) 
DEPARTMENT OF THE ARMY 
 
DEPUTY ASSISTANT SECRETARY OF THE NAVY 
(INTERNATIONAL PROGRAMS) 
DEPARTMENT OF THE NAVY 
 
DEPUTY UNDER SECRETARY OF THE AIR FORCE 
(INTERNATIONAL AFFAIRS) 
DEPARTMENT OF THE AIR FORCE 

 
SUBJECT:  Implementation of Multiple Duration Leases in DSAMS 
 
REFERENCE: (a) Minutes for Lease Duration Meeting, 7 Oct 02, DSADC,    

       Mechanicsburg, PA 
 

 
The Security Assistance Management Manuel (SAMM) delegates the 

administration of Leases (under chapter 6 of the Arms Export Control Act) to the 
implementing agency (IA) responsible for the defense article(s) being leased.  In 
preparing leases, the IA has been limited in DSAMS to a set lease duration period, not to 
exceed five years, for all items contained in a particular lease.  This method has proven 
cumbersome, in that leases with multiple line items often have leased assets returned 
during multiple time periods.  This situation has generated multiple lease amendments to 
reflect the actual time period and rental payment (depreciation) information for which 
each item was leased.   

 
To resolve this problem, reference (a) discussed the development of multiple-

duration leases in DSAMS.  To allow the development of multiple-duration leases in 
DSAMS, the duration of leases must be calculated for each line on a lease, rather than for 
the lease as a whole.  To accomplish this change, the IA will now enter the individual line 
item durations at line level during lease development in DSAMS.  This will require the 
IA to forecast the return date of each item at the line level.  The total lease duration will 
be systemically updated utilizing the longest line item duration period.   The calculation 
for the lease total case value will consider the line duration in lieu of the lease duration.   

 
When a discrepancy occurs between when the IA has stated a leased item will be 

returned in the original lease, and when an item is actually returned, an amendment 
should be prepared moving the items with the changed duration period to a new line and 



removing them from their original line.  The amendment will need to be clearly 
documented so deliveries are moved and not duplicated.   
 
 The duration of leases will continue to be calculated in months only.  The smallest 
lease duration period is one month, and the longest lease duration period is 60 months.  
The time period required to complete major refurbishments is not calculated as a part of 
the lease duration period. 
 
 The changes to DSAMS to allow for the development of multi-duration leases 
will be released with DSAMS 6.09.  If you have any questions regarding this matter, 
please feel free to contact Ms. Dawn Burke at (703) 601-3864.   

 
 
 
      //s// 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
cc: DSADC 



Request for Lease Pricing 
 
 
INSTRUCTIONS:  Obtain data, obtain SAF/IARW coordination, and then provide 
to SAF/FMBIS for pricing and SAF/IAPX for lease initialization. 
 
SAF/IARW Coordination _________________________ 
 
Date of Request ___________________  Country  __________________________ 
 
Office Symbol  ____________________   Requester ________________________ 
 
Description of Item to be Leased  ____________________________________________ 
___________________________________________________________________________ 
 
Status:             __  Routine __  Urgent 
 
Reason for Request: 
 
_______  Customer’s Letter of Request for a Lease (provide copy with completed 
checklist) 
 
Pricing Methodology: (OPR of item to provide) 
 
_______  Excess without replacement 
 
_______  Nonexcess without replacement 
 
_______  Replacement-in-kind 
 
_______  Replacement with an improved item 
 
Price Data: 
 
_______  Tail numbers (aircraft & helicopters) 
 
_______  Serial numbers (missiles/engines) 
 
_______  National Stock Number (all others) 
 
_______  Latest Acquisition Cost (unit flyaway cost/All-Up-Round cost) 

Source:  (SAF/AQPF/Weapons SPO)  
 
_______  Nonrecurring Cost (SAF/FMBIS will provide) 
 



_______  Condition code  
 
_______  Major overhaul (date) 
 
_______  Cost of last major overhaul (if known) 
 
_______  Number of aircraft, missiles, engines, equipment, or helicopters to be 
leased 
 
_______  Term of Lease 
 
Required data to calculate replacement cost and monthly lease cost for aircraft, 
engines, missiles only 
 
Aircraft: 
 
_______  Flight Time on Aircraft  
 
_______  Projected Flight Hours per Month 
 
_______  Total Flight Hours to be flown during lease 
 
_______  Normal Flight Time Life 
 
_______  Flight Time Remaining 
 
Missiles/Engines: 
 
_______  Projected Number of Cycles Per Month (Engines) 
 
_______  Total Cycles per Engine during lease (Engines) 
 
_______  Total Useful Service Life  
 
_______  Service Life Used 
 
_______  Service Life Remaining 
 
SAF/FMBIS will provide based on information obtained above 
 
_______  Replacement Value 
 
_______  Monthly Lease Cost 
 
 



Note:  If the tail numbers or serial numbers are not known, provide the oldest year 
of the aircraft, missile, or helicopter in stock that might be available for lease. 



EDA Pricing Checklist 
 
 
INSTRUCTIONS:  Collect the following information, coordinate with SAF/IARW, 
and then submit request to SAF/FMBIS for pricing.   
 
1. Item ID 
 
 
 
 
 
 
2. For each item provide: 

a. Original acquisition cost (or current stocklist unit price)  
b. Scrap value 
c. Cost of last major overhaul (if known) 
d. Estimated interval between overhauls 
e. Federal condition code 
f. Cost of any Class IV and Class V modifications 

 
 
 
 
2. SAF/IARW Coordination: 
 
 
 
 
SAF/FMBIS will calculate: 
 
1. Total acquisition value 
2. Nonrecurring cost(s) 
3. Current value of each item  
4. Estimated current value of total package 
5. Total package selling price 
 
 
 
 
 
 

  List aircraft by tail number 
 
  List missiles and engines by serial number 
 
  List all other items by NSN 



 

OFFICE OF THE UNDER SECRETARY 

 

 DEPARTMENT OF THE AIR FORCE 
WASHINGTON, DC  

 
 

 
 

21 October 2003 

MEMORANDUM FOR SAF/IAPX 
SAF/IARE 
SAF/IARL 
SAF/IARM 
SAF/IARP 
SAF/IARS 
SAF/FMBIS 

FROM: SAF/IARW 

SUBJECT: Pricing of Excess Defense Articles (EDA) (SAF/IAPX 03034 Memo, 15 Oct 03) 

A checklist attached to SAF/IAPX 030304 Memo identifies all information necessary to 
complete EDA pricing.   

The point of contact for EDA pricing in SAF/IARW is Maj Kari Thyne, (703) 588-8862.  
Country directors must coordinate all EDA pricing requests and issues with her.   

//Signed// 
DENNIS R. MITCHELL, Col, USAF 
Chief, Weapons Division 

 




